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1. Introduction

The Master File database contains static data that reflects the operating characteristics of resources that
participate in California ISO Markets. Periodically, Scheduling Coordinators may need to make changes
to specific operating parameters and may do so by submitting their data changes via a Generator
Resource Data Template (GRDT or RDT), Intertie Resource Data Template (IRDT or RDT), or Use Limit
Plan Data Template (ULPDT). This user guide explains how to use the Master File User Interface for
submitting these data changes, viewing and downloading approved RDT or ULPDT data for a selected
effective trade date, and viewing and downloading a list of resources with upcoming approved changes for
specified date range.

1.1 Purpose

The purpose of the Master File database is to hold static reference data that is used by many key market
applications that operate at the California 1ISO.

1.2 Scope

This manual provides instructions for using the basic Master File User Interface features, which include
the following topics:

+ Accessing the application

« Navigating through the web content and controls

+ Generating and saving reports

The details of how to utilize the Master File Application Programming Interface (Web Services) are
documented in the Technical Interface Specification for Master File Data Exchange Services.
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1.3 Content and Organization

1. The purpose of the guide is to instruct users how to use the features of the Master File User
Interface.

2. This guide describes the steps for submitting (uploading) RDT data updates using three
Excel templates: the GRDT, IRDT, or ULPDT.

3. This guide describes the steps for viewing and downloading data in GRDT, IRDT, and ULPDT Excel
formats.
This application may be used to generate the following reports:

a. Generator RDT Report — data for GEN, TG, LOAD resources in a format used currently to
exchange resource data between CAISO and Scheduling Coordinators. It also allows users to
view/download data which SIBR/IFM/SaMC use to perform validations.

b. Intertie RDT Report — data for ITIE, ETIE resources in a format used currently to exchange
resource data between the CAISO and Scheduling Coordinators. It also allows users to
view/download data which SIBR/IFM/SaMC use to perform validations.

c. Use Limit Plan (ULPDT) Report — data for Use Limit Plans in a format used to exchange ULP
data between the CAISO and Scheduling Coordinators.

d. Resources with Approved Changes - list of resource IDs that have approved changes for a
specified effective trade date, or range of effective trade dates.

4. This guide describes the steps for viewing the status of an uploaded RDT or ULPDT request.
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1.4 Definitions

The following defined terms and acronyms are used within this document:

Object Definition

Approved A submitted data change must be approved by ISO staff before it can
be considered effective.

Approved data changes will be included in the featured reports
beginning the calendar day following the day the change is approved by

ISO staff.
Effective Date The first trading date an approved data change becomes applicable.
SCID A unique identifier for a market participant that is certified by the ISO to
submit bids and preferred self-schedules.
Resource Type Descriptive identifier denoting the type of resource. Different types of

resources may have additional validation requirements. Resource type
can be one of the following:

a) GEN: Generating Resource

b) TG: Dynamic Tie Generator Resource

c) LOAD: Load Resource

d) ETIE: Export System (Intertie) Resource

e) ITIE: Import System (Intertie) Resource

Resource Id The ISO resource identifier used for tracking each resource for market
scheduling and outage coordination purposes.

Trade Date The effective date for which the report retrieves the data from Master
File

ULP Use Limit Plan

ULPDT Use Limit Plan Data Template
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2. Installation

2.1 System Requirements

Hardware
There is no specific limitation on the Hard Disk Drive or the RAM capacity however, a minimum of 512
Mb of RAM is advised for better performance.

Software
* Windows XP or Windows NT 2000 and above
= Internet explorer 6.0 with service pack 2 is recommended
= Microsoft Office 2000 or higher is recommended

Lower versions of the software components may result in some of the user features not looking the
same and some features may be totally unavailable.

2.2 Application Access

Please refer to Appendix A — External User Access for external user access information.

URL information is located in section 3.1 (Using the System).
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2.3 Client Side Setup Procedure

Use this procedure to configure the Microsoft Explorer to open Office files in the appropriate Office
program by using the Folder Options tool. These steps are performed in order to allow the Actuate
Reporting Tool to open Excel files in a separate window, which enhances its usability:

1. Open My Computer.

2. On the Tools menu, click Folder Options.

3. Click the File Types tab.

4, In the Registered file types list, click the specific Office document type (select Microsoft Excel
W orksheets .xls, .csv), and then click Advanced (or click Edit).

5. In the Edit File Type dialog box, click to clear the Browse in same window check box (or click
to clear the Open Web documents in place check box).

6. Click OK.
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3. Using the System

3.1 Accessing the Application

1. Click on the URL for the application:
Master File Production Environment

CAISO Portal

Select

ra) Master File

Please refer to the Master File Production URL List to start Master File

2. A pop-up window appears with the list of available installed certificates displayed. Select the Digital
Certificate with which the request is to be authenticated and click on OK.

Choose a digital certificate

Identification

' The Web site vou wank to view requests
identification. Please choose a certificate.

Marne Issuer
MFRD Internal_Miewer Test_CAZ
MFRD Operator Test_ChZ
MFRD Approver Test_ChZ
Prince Philip Test_CAZ
[ Maore Infa... ] [ Wieve Certificate. .. ]

[ Ok H Cancel ]

3. Figure 1: Login Dialog - CertificateFor the next pop-up window, accept the request to sign data
with the Private Exchange Key of the certificate by clicking on the OK button. This screen should only
appear the first time accessing the application.
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Signing data with your private exchange key

An application iz requesting access to a Protected item.

CryptadPl Private ey

| Q. |[ Cancel ][ Details. ..

Figure 2: Login Dialog — Access
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4. The Master File Home Page will display as shown below

» Welcome: LRivera — March 8, 2016

% California ISO

Shaping a Renewed Future ‘ Master File

Upload Reports Status Actions Data Load Rates Notifications

Upload Reports Status  Actions Data Load Rates Notifications ~ Help

MF Build: mf-6.4.4_b312 ©2016 CAISO, Inc. The contents of these pages are subject to change without notice. Decisions based on information contained
within the California ISO's web site are the visitor's sole responsibility.

Figure 3: Master File Home Page
5. The functionality available includes:

a. Upload (RDT and ULPDT)
b. Reports

C. Status of Submission

d. Actions

e. Data Load

f. Rates

g. Notifications

h. Help

6. Role to Function Matrix
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Function/Role CE))S;;?: External Viewer | |niernal Operator
Upload RDT/ULPDT Data N v
RDT Submission Status \/ v
Reports (Download) Y \ \
Actions \
Data Load v
Rates v
Notifications v
Help \ \ \
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4. Upload of RDT/ULPDT data

4.1 Submission of Upload Request

1. Click the “Upload” button from the home page.

2. The system displays the “Upload” Page. Note the RDT selections require entering Effective Date
and SC ID. These fields are not required/displayed when the ULPDT radio button is selected.

California lSO M . » Welcome: LRivera - February 14, 2018
aster File

Upload Reports Status Actions. Data Load Fates Notifications Help

Upload

File Mame Browse..
Upload Type @) RDT Generator () ROTIntertie ) ULPDT

Effective Date | 0222/2018 [
scio hd

Ccmmem‘ ‘

Upload

Figure 4a: Upload Page for RDT

2 California I1SO|

. » Welcome: LRivera — February 14, 2018
Master File

Help

Upload

File Name Browse...

Upload Type () ROT Generator () RDTIntertie (®) ULPDT

. |

Figure 4b: Upload Page for ULPDT

3. Interact with the following elements on the upload screen:

a. File Name — Must be an .xlIs file in RDT or ULPDT format. The “Browse” button

will allow for file selection from any local or network drive that user is hooked up to. This field
is required.

b. Upload Type — Defaults to “RDT Generator”. Be sure to select “RDT Generator” if a
GRDT is being submitted, “RDT Intertie” if an IRDT is being submitted, or “ULPDT” if a Use
Limit Plan data template is being submitted. A GRDT can contain Generator, TG, and Load
resource IDs, and an IRDT can contain only Intertie resource IDs. This field is required.

c. Effective Date (RDT Only) — Defaults to today plus five business days. The date should be
five or more business days from the current date. Business days exclude weekends and
CAISO holidays. If the five business day rule is broken, an error message will be displayed.

Beginning in Spring 2018, ULPDTs will not be required to adhere to the 5 business day rule.
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Type in a date, or use the calendar popup to select an appropriate date. Only valid dates
will be accepted. This field is required.

d. SC ID (RDT Only) — A list of SC IDs will be displayed which is based on the valid SC IDs in
the Security Certificate for the User who has logged on. Only one SC ID may be selected
per batch submission. All data contained in the file must be associated to the specified SC
ID. This field is required. Note that SC ID is not required for ULPDT uploads.

e. Comments — This field allows you to send comments to the CAISO Business Unit that
pertain to the file being submitted. The comment field is optional.

f.  Upload button — Select the Upload button to submit the file for processing. When Upload is
selected, the system will perform basic structural validation on the RDT file. It will verify that
the file is in the correct format (based on the RDT Type selected), and valid data types are
presented (such as numbers in a numeric field and values based on a list of valid values). For
ULPDTSs, the contents of the file are also validated upon uploading the file. Refer to Appendix
B for User Messages.

4. If no errors are found with the submission, the following screen will appear. Note that there is a
message between the header block and “Upload” title which indicates that the upload
request was successful. The Batch Id associated with this RDT/ULPDT Upload is provided. The
Batch Id is needed for following the progress of this request.

2 Cdlifornia 1SO| S

IMaster File

Upload Reports Status Actions Data Load Rates. Notifications Help
+ RDTfile was successfully uploaded; Batch Id = 863

Upload

File Name Browse.

Upload Type (O RDT Generator (O RDTIntetie (O ULPDT

Comments

[Gpoad |

Figure 5: RDT/ULPDT Successfully Uploaded for Submission
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5. If an error is found upon Upload, a list of the errors will display on the screen as shown in Figure
6: Upload Error Display. Note: once leaving this screen, the errors won’t be available again, a
new upload request will need to be made.

& California ISO| P——

Master File

Reports Actions Data Load Notifications

» The ULPDT file is not valid. See errors below.

Upload
File Name Browse.
Upload Type (O RDT Generator (' RDT Intertie ®) ULPDT
Effective Date | MM/DD/Y YY)
Comments
Upload ]
Processing Errors for file: U:\C Drive 2015\0S\ClientSide Script9.0.0WULP_V2_4_CRxIs

Sheet Name Resourceld Cell/Row Location Error Message
Use_Limit_Plan [DEERCR_6_UNIT 1 H5 Limitation number must be a valid non-negative number
Use_Limit_Plan [GENESI_2_STG Row 3 IThe plan start date for GENESI_2_STG must fall between start and end date of an approved
Use_Limit_Plan [GENESI_2_STG Row 4 [The plan start date for GENESI_2 STG must fall between start and end date of an approved cc
Use_Limit_Plan [GENESI_2_STG Row 4 ULPs with of ROLL_12 must cover twelve or more whole calendar months.
Use_Limit_Plan [GENESI_2_STG Row 4 capacity level has to be greater than minimum capacity
Use_Limit_Plan [DEERCR_6_UNIT 1 Row 5 |The end date ofthe use limit plan must be greater than or equal to the si ion date.
Use_Limit_Plan [DEERCR_6_UNIT 1 Row 5 capacity level has to be greater than minimum capacity .

Figure 6: Upload Error Display
a. Status Bar — Overall message; indicates whether the upload was successful or not.
b. Table of errors — indicates the file name that was used in the upload.
i. Sheet Name — Indicates the worksheet in the Excel file where the error occurred.
ii. Resource Id - Identifies which resource had a problem.

iii. Cell Location — The cell name in the spreadsheet. This will allow you to navigate
directly to the piece of information that has the problem.

iv. Error Message — The message that indicates the nature of the problem. A list of all
possible messages is in Appendix B in this document.

c. Navigational buttons — Allows for moving between multiple pages of errors: (left to right):
i. First — Navigates to the first page of errors

1<<]

Fast Reverse — Navigates 2 pages back from the current page

iii. Previous — Navigates to the previous page of errors
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iv. Numbers — Navigates directly to a page

V. Next — Navigates to next page of errors
Vi. Fast Forward — Navigates 2 pages forward from the current page

2l
Vii. Last — Navigates to the last page of errors

d. Display All Errors — This link will take you to a page that looks like the example below and

will contain a list of all errors rather than a page at a time. The output columns have the same
specification as the partial list specified in step 5 above.

RDT Processing Errors for file: BAD_Intertie_RDT_v2.xls

Sheet Name Resource Id Cell Location Error Message
Intertie Resource| TEST_MARKETO1_E_F_DAD_TEST _MARKETO1_E_F_DAQJ |A3 Resource Id > 32 characters
|Inter1ie Resource| TEST_MARKETO1_E_F_DAD_TEST _MARKETO1_E_F_DAD (B3 Energy Type needs to be FIRM', NFRM', WHL', or 'UCTG'
|Inter1ie Resource| TEST_MARKETO1_E_F_DAD_TEST_MARKETO1_E_F_DAD |C3 Minimum Houtly Block Limit needs to be a valid humber
|Inter1ie Resource| TEST_MARKETO1_E_F_DAD_TEST_MARKETO1_E_F_DAD [F3 Certified for A/S Non Spin RTM needs to be "Y' or 'N'
|Intertie Resource| TEST_MARKETD1_E_F_DAD_TEST_MARKETO1_E_F_DAQD (G3 Spinning Reserve Cap needs to be a valid number
|Intertie Resource| TEST_MARKETO1_E_F_DAO_TEST_MARKETO1_E_F_DAD (I3 Certified for RUC needs to be "Y' or N'
|Intertie Resource| TEST_MARKETO1_E_F_DAD TEST _MARKETO1_E_F_DAQ [N3 YWheeling Reference Number > 32 characters
|Intertie Resource|TEST_MARKETO1_E_F_DAD_TEST_MARKETO1_E_F_DAD (B4 Energy Type needs to be 'FIRM', NFRM', "WHL', or 'UCTG'
|Intenie Resource| TEST_MARKETO1_E_F_DAO C4 Minimum Hourly Block Limit needs to be a valid number
|Intertie Resource| TEST_MARKETD1_E_F_DAO D4 Certified for A/S: Spin needs to be Y' or W'
|Intertie Resource| TEST_MARKETO1_E_F_DAO F4 Certified for A/S Non Spin RTM needs to be ' ar W'
|Intertie Resource| TEST_MARKETO1_E_F_DAO G4 Spinning Reserve Cap needs to be a valid number
|Intertie Resource| TEST_MARKETD1_E_F_DAO H4 MNon-Spinning Reserve Cap needs to be a valid number
|Intertie Resource| TEST_MARKETO1_E_F_DAO 14 Certified for RUC needs to be " or 'N'

Figure 7: Display All Upload Errors
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6. Status of Submission

6.1 Request Status Information

Purpose: This allows you to see the status of batches that have been submitted by a particular SC ID. Only
one SC ID may be selected at a time.

1. Click on the “Status” button on the header block.

2. The system responds by showing the “Batch Status” screen.

% CC]IiFOFniG ISO > Welcome: LRivera — March 14,2018

‘Master File

Upload Reports Actions Data Load Notifications

Batch Status

LMPM Net Buy er with Generation Control Status

scID [ Getstaws |

Figure 12: Batch Status Submission Search Criteria

3. Select or type in the field labeled “SC ID”. The drop down will only include valid SC IDs based on the
security set up in their certificates.

4, Select the “Get Status” button to initiate the system search for RDT/ULPDT Status.

The system returns a screen that will look like the example below and contains a list of Batch
Submissions for the specified SC ID.
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Cdlifornia ISO »» Welcome: LRivera — M

I I T S T E T I

Upload Reports Status Actions Data Load Notifications

RDT Status

LMPM Net Buyer with Generation Control Status

SCID JEINEN ~ Get Status

1s a Net Buyer with Generation Control

mn

Submit Date File Name Batch ID Status Batch Change Date Effective Date Subm
Mar 9, 2016 Generator RDT Version 10 LR Bad.xlsx 10236 Validation Error Mar 9, 2016 Mar 16, 2016 LRivera
Mar 9, 2016 Generator ROT Version 10 SK xlsx 10234 Submitted IMar 9, 2016 Mar 16, 2016 LRivera
Mar 9, 2016 Generator ROT Version 10 HUMB . xlsx 10233 Submitted Mar 9, 2016 Mar 16, 2016 LRivera
Dec 10, 2015 Generator RDT Version 10.0 (1) xlsx 10232 \alidation Error Dec 10, 2015 Dec 22,2015 SKESIREDDY
Dec 10, 2015 Generator RDT Version 10.0 (1) xlsx 10231 Validation Error Dec 10, 2015 Dec 22, 2015 SKESIREDDY
Dec 10, 2015 Generator RDT Version 10.0.xlsx 10230 Validation Error Dec 10, 2015 Dec 21,2015 SKESIREDDY
Dec 9, 2015 Generator RDT Version 10 nonmsg.xlsx 10229 Submitted Dec 9, 2015 Dec 16, 2015 LRivera
Dec9, 2015 Generator RDT Version 10 nonmsg.xIsx 10228 Validation Error Dec 9, 2015 Dec 16,2015 LRivera
Dec9, 2015 Generator RDT Version 10.0.xlsx 10227 Validation Error Dec 9, 2015 Dec 21,2015 LTester47
Dec 9, 2015 Generator RDT Version 10.0 xlsx 10226 Validation Error Dec 9, 2015 Dec 21,2015 L Testerd7
Dec 9, 2015 Generator RDT Version 10.0.xlsx 10225 Validation Error Dec 9, 2013 Dec 16,2015 LTesterd7
Dec 8, 2015 Generator RDT Version 10 HUMB xlsx 10224 Submitted Dec 8, 2015 Dec 15,2015 LRivera
Dec 8, 2015 Generator RDT Version 10.0 (3) xlsx 10223 Submitted Dec 8, 2015 Dec 15,2015 L Testerd7
Dec 8, 2015 Generator RDT Version 10.0 (2).xlsx 10222 Submitted Dec 8, 2015 Dec 15,2015 LTester47
Dec 8, 2015 Generator RDT Version 10 HUMB xlsx 10221 Submitted Dec 8, 2015 Dec 15, 2015 LRivera

K] 12345 [2][»][»] B

< | ] | »

Figure 13: Batch Submission Status Display

6. The Batch Status screen contains the following data:
a. Submit Date — The date the batch was submitted.

b. File Name — The name of the input file (RDT/ULPDT). This will be an .XLS file when submitted
by the Ul and an . XML file when submitted by the API.

C. Batch ID — This is the system-generated unique identifier associated to the Batch.
d. Status — Displays the current status of the batch. The possible values are as follows:

i. Request to Load — The XLS file has been uploaded, and your file is in the queue for
automated validation.

ii. In Process — Your file is currently being validated in the automated validation process.

iii. Submitted — The automated validation is complete, there were no validation errors, and
your changes are ready for review and approval by the 1SO.

iv. Validation Error — The automated validation found errors in your file. You will receive an
email notification from ISO staff that includes the details of the errors.
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V. Approved — Your changes have been approved by the ISO Approver and will be
implemented on the requested effective date. Please note, approved changes will not be
visible in the RDT/ULPDT reports or in the Resources with Approved Changes report until
the day after batch status changes to Approved.

Vi. Declined — Your changes have been declined by the ISO Approver. You will receive an
email notification that includes the details.

e. Batch Change Date — The date the last change occurred to the batch.
f.  Effective Date — The date that the change will become effective
g. Submitter — The name of who submitted the change.

Each column in the display can be used to sort the results. This is accomplished by clicking on the title
of the column to be sorted. An arrow will show which direction (ascending or descending) the data will
be sorted. If clicked a second time, the system will sort the data the opposite direction.
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7. Reports

1. The Master File Actuate application opens in the Internet Explorer window with the default screen
displayed below. The default folder selected is your Personal Folder. The left navigation pane
displays the folders to which you have access.

“3‘1 California 1SO Reporting & L 7 | Rking

[ kbmenee | Do [ ey Upload | ClMaragetoter | FView | oo -

[D Home

Home

FOLDERS

D Master File

Figure 14: Main Page — Default Folder

Note: The top right hand corner of the screen displays the name of the user that has logged in.

Page 20 of 54
Version 1.8 Copyright © 2018 CALIFORNIA INDEPENDENT SYSTEM OPERATOR. All rights reserved. 3/15/2018
Information in this document is subject to change.



Master File User Interface User Guide

7.1 Generating the Reports

1. Select the ‘Master File’ folder on the left navigation pane. This displays the list of reports that you
have access to.

The following reports are available for view and download:

. Generator RDT Report — data for GEN, TG, LOAD resources in the format used to
exchange resource data between the ISO and Scheduling Coordinators.

. Intertie RDT Report — data for Intertie resources (ITIE or ETIE) in the format used to
exchange resource data between the ISO and Scheduling Coordinators.

. Resources with Approved Changes — see Section 6.3.

. ULPDT Report — data for Use Limit Plans in the format used to exchange Use Limit Plan
data between the ISO and Scheduling Coordinators.

2. Select the report to generate by clicking on the tile for the relevant report (e.g. Generator RDT)

Map Test

& California ISO | Reporting B 7 s

ﬂ] Master File Sandbox

Home > Master File Sandbox

FOLDERS

PAGINATED REPORTS

Generator RDT Version Generator RDT Version

110 120 @ Intertie RDT Version 4.0 @ Intertie RDT Version 5.0
Resources with Approved ** .
Changes Becoming @ ULPDT Version 1.0 @ ULPDT Version 2.0

Effective

Figure 15: Master File Folder

3. The screen refreshes to display the report parameters specific to the report, in the upper pane .
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% California 1SO Reporting &L 7 g

Home > Master File » Generator RDT Version 10.0

Trading Date: | &= View Report
SCID: &7 Resource Type: | <Select a Value> v
Resource ID: v

Figure 16: Generator RDT Report Screen
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% California ISO | Reporting &L | 2 Reg

Home > Master File > ULPDT Version 1.0

Trading Date: | | ﬁ View Report
SCID: W Use Limit Type: | <Select a Value> v
Granularity: | =Select a Value> v Resource ID: e

Figure 17: ULPDT Report Screen
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4. Type in the Trade Date for which the report is to be generated, or you may use the calendar box by
clicking on the calendar icon next to the Trade Date field and selecting the required date from the
calendar box.

“"v‘ California ISO ' Reporting B L 7 g
reene Dsewe

Home » Master File > ULPDT Version 1.0

Trading Date: | | View Report
4 March 2018 3
SCID: s M T W T F s Use Limit Type: | <Select a Value> ™
o 25 26 27 28 1 2 3
Granularity: Resource ID: v
5 [ 7 8 9 10
1n 12 1 15 16 17 —

18 19 20 sl 22 23 24
25 26 27 28 29 30 31

Today is Wednesday, March 14, 2018

Figure 18: Calendar Box
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5. Select the SCID from the drop down list of available SC IDs that have associated resources for the
selected Trade Date.

“‘% California I1SO | Reporting & L 7 Rang
= = |

Home > Master File > ULPDT Version 1.0

Trading Date: [3/14/2018 | View Report
SCID: <Select a Value> id Use Limit Type: | <Select a Value> ™
Granularity: | <Select a Valug> Vv Resource ID: v

Figure 19: SCID List

Note: The Resource Type and Resource ID lists default to ‘<Select a Value>' .
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6. If generating an RDT report, select the Resource Type to generate the report (e.g. GEN). The

available options are:

« Generator RDT Report —ALL, GEN, TG, LOAD
« Intertie RDT Report — ALL, ETIE, ITIE

Selecting the ‘ALL’ option for Resource Type will result in the report including information for all the
listed resource types for each RDT report as listed above, if it exists. Or you can select any one of the
applicable resource types from the list to generate the report for a single resource type.

“‘% California ISO | Reporting @ L | ? | Rng

Home » Master File » Generator RDT Version 10.0

Trading Date: |a/14/201s | = View Report
SCID: <Select a Value> v Resource Type: [ a R
ALL
Resource ID: ~ GEN
TG
=]

LOAD

Figure 20: Resource Type List
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7. If generating a ULPDT report, select the Limitation Type. The available options are: ENERGY,
RUNHOURS, START, OTHER and ALL.

Selecting the ‘ALL’ option for Limitation Type will result in the report including information for all the
listed limitation type as listed above, if it exists. Note that the drop down list only includes Limitation
Types for existing approved Use Limit Plans. (If no approved ENERGY Use Limit Plan already exists,
‘ENERGY’ will not appear in the drop down list.) Optionally you can select any one of the applicable
limitation types from the list to generate the report for a single limitation type.

&> California ISO | Reporting & L 7 nang

Home > Master File > ULPDT Version 1.0

Trading Date: [3/14/2018 | View Report
SCID: =Select 3 Value> ¥ Use Limit Type: [EEEERE T3

ALL
Granularity: <Select a Value> v Resource ID: OTHER

RUNHOURS
ENERGY
START

Figure 21: Use Limit Type List
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8. After selecting the Use Limit Type for a ULPDT report, select the Granularity. The available options
are: ANNUALLY, ROLL_12, MONTHLY, DAILY, OTHER and ALL.

Selecting the ‘ALL’ option for Granularity will result in the report including information for all the listed
granularities as listed above, if it exists. Note that the drop down list only includes Granularities for
existing approved Use Limit Plans. (If no approved monthly Use Limit Plan already exists,
‘MONTHLY” will not appear in the drop down list.) Optionally you can select any one of the applicable
granularities from the list to generate the report for a single granularity.

& California ISO | Reporting L7

s RKing

Home » Master File > ULPDT Version 1.0

Trading Dates [3/14/2018 |

Wiew Report
SCID: <Select a Value> VvV Use Limit Type: | <Select a Value> v
Granularity: |G ERETSS Resource ID: v
ALL
OTHER —

DAILY
ANNUALLY
MONTHLY

Figure 22: Granularity List

9. Once the other filters are selected, the Resource ID list is refreshed with all the qualifying

resources to which the SC ID is associated. Again, the drop down list only includes Resources for
existing approved Use Limit Plans.

Select ‘ALL’ from the drop down list to generate a report including all the Resource IDs with
the specified filters.

Select a single Resource ID to generate a report for just that Resource.

Note: Reports can only be run for ‘ALL’ resources or one specific resource at a time. The
reports do not allow for multiple Resource ID selections.
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%% California ISO  Reporting B L 7 wang

Home > Master File > ULPDT Version 1.0

Trading Date: [3/14/2018 |
sciD: Use Limit Type: [START v
Granularity: Resource ID: ALL hd

——

Figure 23: Resource Id List
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10.Click on the ‘View Report’ button to generate the report.

“‘% California ISO | Reporting B L 7 Reng

Home » Master File > ULPDT Version 1.0

Trading Date: [3/14/2018 |
SCID: T5T1 W Use Limit Type: |START hd
Granularity: | MONTHLY v Resource ID: ALL b

——

Figure 24: View Report
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7.2 Download and Viewing the Reports

1. Upon clicking the ‘View Report’ button, the application processes the request in the background
and, when complete, displays the file download instructions.

* Click on ‘Export’ menu (under the disk icon) and select the “Excel designed by
OfficeWriter” option to begin the file download.

» Click on ‘Open’to view the report directly — Go to step 4 for further instructions for
viewing the report directly.

e Click on ‘Save’ to download the report prior to viewing it. — Go to step 2 for further
instructions on downloading the report.

« Click on ‘Cancel to terminate the request.

“‘% California ISO | Reporting B L 7 g
|

Home » Master File > ULPDT Version 1.0

Trading Date: |3/14/2018 |
SCID: TST1 e Use Limit Type: [START e
Granularity: | MONTHLY hd Resource ID: ALL hd

4< [ Jetr > Bl O ® By & [ [anaines

To export the report, please open the Export menu ( - ) and select Excel designed by OfficeWriter

Figure 25: File Download Instructions
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& California ISO | Reporting & L 2 Reng

Home » Master File > ULPDT Version 1.0

Trading Date: |3,I14f2018 | View Report

SCID: TSTL hd Use Limit Type: |START v
Granularity:  |MONTHLY W Resource ID: ALL hd

Ko< Jor > bl O @ By & [ rndinen

To export the report, please open the Export menu ( 2] designed by OfficeWriter

Word

Excel

PowerPoint

PDF

TIFF file

MHTML {web archive)

CSV (comma delimited)

XML file with report data

Data Feed

Excel designed by Officewriter

Word designed by OfficeWriter

Figure 26: Export Format Selection
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VN = hitps://reporting. caiso.com/ reparts/ repart/Master20File/ ULPDT %20VersionS:201.0 -ac L e

@ ULPDT Version1.0 - SQL Se.. *
File Edit View Favorites Tools Help
s B Suggested Sites = || CalI50 > |, Projects = |, Salesforce.com = | CIDI-SMC Production 550 [l Home - Corporate Systems #%) IT Asset Configuration Edi...

4 https--fipucn00L.wepexn... ] Web Slice Gallery =

‘g‘% California ISO Reporting @ L | 7 | g

Home » Master File > ULPDT Version 1.0

Trading Date: ‘3/‘14}’2018 | View Report

SCID: TST1 hd Use Limit Type: |START hd
Granularity:  |MONTHLY hd Resource ID: ALL v

4 < E oz > B O @ By & [ ]rindlnen

To export the report, please open the Export menu ( « ) and select Excel designed by OfficeWriter

7 Open Save | T Cancel

Do you want to open or save ULPDT Version 1.xlsx from
H100% v

Figure 27: File Download
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2. Upon clicking the ‘Save’ button, the ‘Save As’ window opens and provides you an option to browse to
a destination folder and save the report.

,_g Save As

@'\:j'l J v lteration 2 v | +4 | | Search Iteration 2 §el |
=~ @

Mame Date modified Type Size

Organize « Mew folder

~
- Favorites

B Desktop No items match your search.
4 Downloads

=
= Recent Places

m

- Libraries
3 Documents
J’- Music | 4
&= Pictures

E Videos

M Computer

& 05 ()

il medmmine M crifiameni1 70 R

File name: ULPDT Version 1.xlsx

Save as type: | Microsoft Excel Worksheet (*.xlsx) v]

Save l I Cancel ]

“ Hide Folders

Figure 26: Save As — Browse Window

Note: You may rename the report file to a file hame of your choice.
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3. When the file download is complete and the report has been saved to the selected destination folder,
the ‘Download Complete’ pop-up window appears and you may click on the ‘Open’ button to view the
report.

=] X

LG © hitpsi//reporting.caiso.com/reports/report/Master20File/ ULPDT%20Version 32010 14 ok I

(& ULPDT Version 1.0 - 5QL Se...

File Edit View Favorites Tools Help
s B Suggested Sites v || Cal-150 = || Projects v || Salesforce.com v [ CIDI-SMC Production 550 [[] Home - Corporate Systems % IT Asset Configuration Edi... s https--fipucn001.wepexn.. & Web Slice Gallery =

‘wg“% California ISO | Reporting @ L 7 g

Home » Master File > ULPDT Version 1.0

Trading Date: ‘3]14{2018 ‘ i View Report

SCID: TST1 e Use Limit Type: |START N
Granularity: | MONTHLY hd Resource ID: ALL hd

K< L ot > bl O @ By & [ [rndines

To export the report, please open the Export menu ( « ) and select Excel designed by OfficeWriter

Do you want to open or save ULPDT Version Ladsx from reporting.caiso.com? Open Save | v| Cancel | ® -
#100%

Figure 27: Download Complete
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4. The system will prompt user to select one certificate to use.

Choose a digital certificate

Identification 5
The Wweb site wou want to view reguesks
' identification, Please choose a certificate.

Marne Issuer ki
MFRD Ciperator CAISC_TEST A

LMP Tester33 CATSO_TSSUING_CA

LNP Teskerl? CAISD_ISSUING_Ch

LMNP Teskerzd CAISD_ISSUING_Ch

LNP Tester43 CAISD_ISSUING_Ch

LMNP Teskter40 CAISD_ISSUING_Ch

LMNP Teskerd? CAISO_TISSUING_Ch b
£ >

More Infa... ] [ View Certificate. .. ]
[ [0]'4 ] [ Cancel ]

Figure 28: Choose Certificate

5. Note: If you have Excel already open, the request to choose a certificate may be hidden on the Excel
Screen. If it seems like it is taking forever, click on the Excel icon and the prompt for certificate
should come to the foreground.
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6. Note: The file name is always the same so if you currently have a generator open and try to open
another one you will receive an error that looks like this. You can avoid this problem by saving as
another name before opening a new generator.

£
ﬂ_] Ele Edit Yiew Insert Format Tools Data  Window Help Type
N SE ST A BB A0 e A RS o .1 2B Z U= EE A
i Tt ot B e S | | 2] B 1 | ¥ Reply with Changes... End Revisw... !
i q Create CSYs from RDT 2 Merge CSY files H
A3 - f Gas Recovery Systems, Inc
A | 8 [ c 3 [ e ] F [ G [ 1 |
Scheduling Resource Prime Mic
PGA Mame Coordinator ID Resource ID Resource Name Type Aggregate? Energy Type  Fuel Type Technoh
PGa MAME SC D RES_I RES_MNAME RES_TVPE AGGREGATE_VNEMERGY _TYPEFUEL_TYPE GEM_TECH
BGAS

Microsoft Excel WATR

BGAS STUR
A document with the name 'Generator RDT.vtF is already open. You cannot open two documents with the same name, even if the documents are in FIRM GAS HYDR

! different folders, FIRM GAS HYDR
To open the second document, sither close the document that's currently open, or rename one of the documents, FIRM GAS HYDR

APK1 TEST_BRL132.11 TEST_BRL132.11 LOAD N FIRM GAS HYDR

APK1 TEST_BRL132.23 TEST_BRL132.23 LOAD M FIRM GAS HYDR

APK1 TEST_BRL132.35 TEST_BRL13235 LOAD M FIRM GAS HYDR

APH1 TEST_BRL132.47 TEST_BRL132.47 LOAD il FIRM GAS HYDR

APK1 TEST_BRL132.4 TEST_BRL132.4 6 N FIRM GAS HYDR

APH1 TEST_BRL1325 TEST_BRL1325 TG i) FIRM GAS HYDR

LPH1 TEST_BRL1326 TEST_BRL132E TG i) FIRM GAS HYDR

Figure 29: Error — Duplicate File Name

7. The generated report opens up in Microsoft Excel as a workbook with the following worksheets in it:

e Generator RDT Report — Instruction, Definition, Code, RESOURCE, RAMPRATE,
HEATRATE, STARTUP, FORBIDDEN OPR REGION, REGULATION, REG RAMP, OP
RES RAMP

- Intertie RDT Report — Instructions, Pick Lists & Reference, Intertie Resource (Existing)

« ULPDT Report - Instructions, Definition, Code, Use_Limit_Plan
8. The reports display the following information on the Instruction sheet.

a) Report generation timestamp: The timestamp at which the report was
generated (e.g. 01/11/2008 07:59)

b) SCID: The SCID for which the report was generated

C) Resource Type (RDTs only): The Resource Types selected when the
report was generated (e.g.: Gen/Load/TG/All)
d) Resource ID: ALL or the selected Resource ID (‘ALL’ includes all the

resources of the Resource Type that are associated to the SCID for the
trade date, as selected.)

e) Trade Date: Effective trade date for which the report has been
generated. Because Resource Adequacy capacity and must-offer status
can potentially vary on a daily basis, the Resource Adequacy capacity
and flag values should be considered valid for only the trade date the
report was run. To see Resource Adequacy values for another Trade
Date, the report should be generated for that Trade Date.
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“3 Cc:|if9r“nio IS

g o Renewed

Generator Resource Data Template (GRDT)

Version GRDT.10.0

W N =

5 |Report generation timestamp :
6 |scID H

7 |Resource Type

8 |Resource ID

9 |Trade Date

10
11
12
13
14
15 Version Effective Date Description of Change
74 9.1 Fall Release 2014 |Add new columns:
75 RESOURCE tab:
76 Add new fields: EIM_PARTICIPATING, BAA
77 Add new tab:
78 GEN_RES_AGGR: Contains resource |ID, name, and Pmax, of child units belonging to aggregate resources - Read-only
79 Changes:
80 10.0 Fall Release 2015 | RESOURCE tab:
81 Add new field: GHG_COST
82 MSG_CONFIG tab:
83 Add new field: STARTUP_YN
84
- » Instruction | Definition | Code | RESOURCE RAMPRATE HEATRATE STARTUP FORE ... @.: 4 »
Figure 30: View Report — Instruction sheet
9. Click on the relevant worksheet tab to view the data within the worksheet
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loix]
3 @_] File Edit View Insert Format Tools Data FlashPaper Window PI  Help Type aquestionforhelp « - & X
: il -0 +|B Z U s % RS EEE--AB
DEHRISRVE $RBA-F9-0 8= -4i @B -0
A3 52 A WILE E ENERGY
& | B | C D [ F | G | H | [ 9 1 K | L M 4
Air Quality  Maximum —
Scheduling Resource Prime Mover ~ Generator Managment  Generatio
| 1] PGA Name Coordinator ID Resource ID Resource Name Type Aggregate? Energy Type Fuel Type  Technology Type Fuel Region District n
2 PGA NAME SC_ID RES_ID RES_NAME RES_TYPE AGGREGATE_YN ENERGY _TYPEFUEL_TYPEGEN_TECH_TYPEGEN_TYPEFUEL REGN_TYPEAGM DIST_TYPE MAX_GEN
3 LEE ENERGY___Jscac ATESTUNITO01 TEST_UNIT_001 GEN N OTHR Scac 100
4 | SCac A1TESTUNITO02 TEST_UNIT_002 GEN i) OTHR SCac 100
| 5 |WILE E ENERGY SCac 1TESTUNITO03 TEST_UNIT_003 GEN N OTHR SCac 100
| 6 |WILE E ENERGY SCac ATESTUNITOO4 TEST_UNIT_D04 GEN N OTHR SCac 100
| 7 | Scac ATESTUNITO0S TEST_UNIT_00S GEN N OTHR Scac 100
| 8 | SCac ATESTUNITO0S TEST_UNIT_006 GEN M OTHR Scac 100
| 9 | SCac 1TESTUNITOO7 TEST_UNIT_007 GEN N OTHR SCac 100
110 | SCaC ATESTUNITOOS TEST_UNIT_D08 GEN N OTHR SCacC 100
| 11 |WILE E ENERGY SCaC 1TESTUNITO0S TEST_UNIT_009 GEN N OTHR SCacC 100
| 12 |WILE E ENERGY SCaC ATESTUNITO10 TEST_UNIT_010 GEN N OTHR SCacC 100
| 13 |WILE E ENERGY SCacC 1TESTUNITO11 TEST_UNIT_011 GEN N OTHR SCacC 100
| 14 |WILE E ENERGY SCaC ATESTUNITO12 TEST_UNIT_012 GEN N OTHR SCacC 100
115 | SCacC ATESTUNITO13 TEST_UNIT_013 GEN N OTHR SCaC 100
116 | SCacC ATESTUNITO14 TEST_UNIT_014 GEN N OTHR SCacC 100
| 17 |WILE E ENERGY SCacC 1TESTUNITO1S TEST_UNIT_015 GEN N OTHR SCac 100
| 18 WILE E ENERGY SCaC ATESTUNITO16 TEST_UNIT_016 GEN N OTHR SCaC 100
119 | SCacC ATESTUNITO17 TEST_UNIT_017 GEN N OTHR SCaC 100
| 20 WILE E ENERGY SCaC ATESTUNITO18 TEST_UNIT_018 GEN N OTHR SCac 100
| 21 WILE E ENERGY SCacC 1TESTUNITO1S TEST_UNIT_018 GEN N OTHR SCac 100
122 | SCaC ATESTUNITO20 TEST_UNIT_020 GEN N OTHR SCac 100
| 23 WILE E ENERGY SCaC ATESTUNITO21 TEST_UNIT_021 GEN N OTHR Scac 100
| 24 WILE E ENERGY SCaC 1TESTUNITO22 TEST_UNIT_022 GEN N OTHR SCac 100
125 | SCac 1TESTUNITO23 TEST_UNIT_023 GEN N OTHR SCaC 100
126 | SCaC 1TESTUNITO24 TEST_UNIT_024 GEN N OTHR SCac 100
| 27 |WILE E ENERGY SCac A1TESTUNITO25 TEST_UNIT_025 GEN N OTHR SCac 100
128 | SCaC 1TESTUNITO26 TEST_UNIT_026 GEN [\l OTHR SCac 100
| 29 |WILE E ENERGY SCac ATESTUNITO27 TEST_UNIT_027 GEN N OTHR SCac 100
130 | SCac 1TESTUNITO28 TEST_UNIT_028 GEN N OTHR SCac 100
| 31 |WILE E ENERGY SCac 1TESTUNITO29 TEST_UNIT_029 GEN N OTHR Scac 100
| 32 |WILE E ENERGY SCac A1TESTUNITO30 TEST_UNIT_030 GEN N OTHR SCac 100
| 33 |WILE E ENERGY Scac ATESTUNITO31 TEST_UNIT_031 GEN N OTHR Scac 100
134 | SCac ATESTUNITO32 TEST_UNIT_032 GEN N OTHR SCac 100
135 | SCacC 1TESTUNITO33 TEST_UNIT_D33 GEN N OTHR SCacC 100
| 36 |WILE E ENERGY SCaC 1TESTUNITO34 TEST_UNIT_034 GEN N OTHR SCac 100 =
£ o 4TECTLpITAYE TeeT LT 02 chl nL TuR. 0 100
W 4 » M\ Instruction / Definition / Code ) RESOURCE / RAMPRATE { HEATRATE £ STARTUP / FORBIDDEN OPR REGION £ REGULATION / REGRAMP / OPRESRAMP / [4] | |
Ready NUM 4

Figure 31: View Report — Resource sheet
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ol
3 File Edit Vew Insert Format Tools Data FlashPaper ‘Window PI  Help Type aquestionforhelp  ~ o & X
: avial -0 -B7yulsEE=HSs % BAEEE-5-A-B
NEHRSSRIVE ¥ LBR-F(9-0-18=-41% @ -0f
Al v % Resource ID
A B | c | D | E | B L 6 1|3
1 |Resource ID Segment Type Segment Number Operating Level Worst Operational Ramp Rate Best Operational Ramp Rate Comment =
| 2 [1TTESTUNITOD1 RAMP 1 10 50
| 3 [1TESTUNITOD2 RAMP 2 100 51 100
| 4 [1TESTUNITOO3 RAMP 1 0 10 50
| 5 |1TESTUNITOD4 RAMP 1 100 51 100
| 6 | 1TESTUNITODS RAMP 2 0 10 a0
| 7 [1TESTUNITOOB RAMP 2 100 51 100
| 8 [1TESTUNITOO? RAMP 1 0 1 9
| 8 [1TESTUNITOOS RAMP 2 100 10 100
| 10 [1TESTUNITOD9 RAMP 2 0 10 50
| 11 [1TTESTUNITO10 RAMP 2 100 51 100
| 12 MTESTUNITO11 RAMP 1 0 10 50
| 13 1TESTUNITD12 RAMP 1 100 51 100
| 14 MTESTUNITD13 RAMP 1 0 10 50
| 15 [1TESTUNITO14 RAMP 2 100 a1 100
| 16 | 1TESTUNITD15 RAMP 1 i 10 50
| 17 [1TTESTUNITO16 RAMP 1 100 51 100
| 18 1TESTUNITO17 RAMP 1 0 10 50
| 19 [1TESTUNITDO18 RAMP 2 100 51 100
| 20 [1TESTUNITO19 RAMP 1 0 10 50
| 21 1TESTUNITO20 RAMP 2 100 51 100
| 22 MTESTUNITO21 RAMP 1 0 10 50
| 23 [ 1TESTUNITOZ22 RAMP 2 100 51 100
| 24 MTESTUNITO23 RAMP 1 0 10 50
| 25 |1TESTUNITO24 RAMP 2 100 51 100
| 26 |1TESTUNITO25 RAMP 1 0 10 50
| 27 1TESTUNITO26 RAMP 2 100 51 100
| 28 1TESTUNITOZ7 RAMP 1 0 10 50
| 29 1TESTUNITO28 RAMP 2 100 51 100
| 30 1TESTUNITO29 RAMP 1 0 10 a0
| 31 1TESTUNITO30 RAMP 2 100 51 100
| 32 1TESTUNITO31 RAMP 1 i} 10 50 =
1€ <% Wi\ Instruction £ Definition / Code #f RESOURCE ) RAMPRATE / HEATRATE /{ STARTUP /. FORBIDDEN OPR REGION  REGULATION £ REa |« =~ | LIJ_‘
Ready UM S

Figure 32: View Report — Segment sheet
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7.3 Resources with Approved Changes Becoming Effective

Map Test

“‘1 California ISO | Reporting L7 e

ﬂ] Master File Sandbox

Home > Master File Sandbox

FOLDERS

PAGINATED REPORTS

Generator RDT Version Generator RDT Version

110 120 @ Intertie RDT Version 4.0 @ Intertie RDT Version 5.0
Resources with Approved *** °
@ Changes Becoming @ ULPDT Version 1.0 @ ULPDT Version 2.0

Effective

Figure 33: Main Reporting Screen

1. Todisplay a list of resources that will have changes during a particular time frame, the Resources
with Approved Changes Report may be generated. This report is useful for identifying when a bid
may need to be modified. The report does not include the actual changes, but will show the effective
data of a change. An RDT can then be generated for that effective date to see the actual latest data.
The largest range of days that may be selected when generating this report is 30 days.

2. The default date criterion is as follows:

From Date: Today
Through Date: Today + 7 days
SC ID: Is Required

3. Please Note: The Approved Changes Report will not show resources with changes until the day after
the change was approved.

7.3.1 Search Criteria
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Figure 34: Enter Report Search Criteria
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Microsoft Excel - Resources with Approved Changes Becoming Effective.xls ;lgﬁl
:@J File Edit View Insert Format Tools Data FlashPaper Window PI  Help Ty estionforhelp  « o & X
: arial -2 LBz uEEEE]S % 0 B E-o-A-f

DEHRISRYE| DR S0 -0- 85 415 @ w -0f

Al i # Resources with Approved Changes Becoming Effective
A | B [ [ D | E | F G H il

1 Resources with Approved Changes Becoming Effective Ml

| 2 |SCID: 8CIC Date Range: 10/01/2008 through 1043072008
Effective Resource Submission

| 3 |Date Resource ID Resource Name Type Submitter Date File Name Approval Date  Batch ID
| 4 |10/1/2008 | SCSC_RIKER_E_F_ALPHA SCIC_RIKER_E_F_ALPHA ETIE
| 5 |10/1/2008  SCIC_RIKER_E_F_BAKER SCIC_RIKER_E_F_BAKER ETIE
| 6 {10/1/2008 | SCIC_RIKER_E_F_CHARLIE SCIC_RIKER_E_F_CHARLIE ETIE
| 7 [10/1/2008 | SCSC_RIKER_E_F_DELTA SCIC_RIKER_E_F_DELTA ETIE
| 8 |10/1/2008 | SCIYC_RIKER_E_F_FOXTROT SCIC_RIKER_E_F_FOXTROT ETIE
| 9 [10/1/2008 | SCSC_RIKER_E_NF_ALPHA SCIC_RIKER_E_NF_ALPHA ETIE
| 10 [10/1/2008 | SCSC_RIKER_E_NF_BAKER SCIC_RIKER_E_NF_BAKER ETIE
| 1110/1/2008 | SCYC_RIKER_E_NF_CHARLIE SCIC_RIKER_E_NF_CHARLIE ETIE
| 12[10/1/2008 | SCSC_RIKER_E_NF_DELTA SCIC_RIKER_E_NF_DELTA ETIE
| 13/10/1/2008  SCYC_RIKER_E_NF_FOXTROT SCIC_RIKER_E_NF_FOXTROT ETIE
14 {10/1/2008 | SCIC_RIKER_E_|_ALPHA SCIC_RIKER_E_|_ALPHA ITIE
| 15 [10/1/2008 | SCSC_RIKER_E_|_BAKER SCIC_RIKER_E_|_BAKER ITIE
| 16 10/1/2008 | SCIC_RIKER_E_|_CHARLIE SCIC_RIKER_E_|_CHARLIE ITIE
| 17 [10/1/2008  SCSC_RIKER_E_| DELTA SCIC_RIKER_E_|_DELTA ITIE
| 18 /10/1/2008 | SCIC_RIKER_E_|_FOXTROT SCIC_RIKER_E_|_FOXTROT ITIE
| 19 [10/1/2008 | SCSC_RIKER_I_NF_ALPHA SCIC_RIKER_|_NF_ALPHA ITIE
| 20 [10/1/2008 | SCSC_RIKER_|_NF_BAKER SCIC_RIKER_|_NF_BAKER ITIE
| 21 /10/1/2008  SCYC_RIKER_I_NF_CHARLIE SCIC_RIKER_|_NF_CHARLIE ITIE
22 |10/1/2008 | SCIC_RIKER_|_NF_DELTA SCIC_RIKER_|_NF_DELTA ITIE P
| 23 10/1/2008  SCIC_RIKER_|_NF_FOXTROT SCIC_RIKER_|_NF_FOXTROT ITIE

| 24 |10/1/2008

BASKERVILLE

SMALL QF AGGREGATION - BASKERYILLE GEN

Ready

4 4 » w\Sheet1 /

K1

NUM

| ur

4

Figure 35: Report Output

The report output is presented in an Excel Spreadsheet with a default sort order of ascending by effective
date (smallest date to largest). To see the details of the changed Approved data, the RDT report must be
generated for the Effective Date listed in the Approved Changes report.
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7.4 Program Limitations

1. Reports can only be run one specific resource. At this time, the reports do not allow for multiple
Resource Id selections.

2. Reports include only “Approved” data.

3. “Approved” data is included in reports beginning on the calendar day following the day a data change
has been approved by ISO staff.
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8. Data Load

8.1 Uploading using the Data Load feature (internal users only)

1. Click the “Data Load” tab from the home page.
2. The system displays the “Data Load Page” as below.

\: Californio ISO » Welcome ] - Janvary 22, 2015
' Shaping o Renewed Fute ¢ M aster File

Upload Reports Status Actions Rates Notifications

Data Load

File Name No file selected.

File Type Association

Figure 36: Data Load Page

3. Interact with the following elements on the data load screen:

a. File Type — Select the type of file that needs to be uploaded. The options are:
. Association
. Contract
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. Group

. Group Detall
. Participant
. Resource

Each file type from the above list uses a different template and the uploaded file is validated
against a different set of rules based on this selection once the file is accepted for
processing.

File Name — Use the “Browse” button to locate and select the file that you want uploaded
and the “Load” button to upload the selection for processing. When Load is selected, the
system will perform basic validation on the file. For example, it will verify that the file name
is not more than 100 characters and the extension is either .xls or .xIsx for “Resource”
and .csv for the other options. If these validations fail, the file will not be accepted and an
error message explaining the reason will display on the upper left hand corner of the
screen. The errors can be addressed and the file can be re-uploaded.

Once the upload is successful, a “zip” file will be presented to the user with information
related to the basic validation on the data. The batch will be set to “Fail” status if the data
does not meet the criteria.
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9. Actions

9.1 Actions related to Batch

Purpose: The purpose of this tab is to let internal admins review and take action on a batch.

1. Click on the “Actions” tab on the header block.

2. The system responds by showing the “Actions” screen.

% Cdlifornia 1SO e e

IMaster File

Actions Data Load FRates Notifications. Help

Actions

Action v Batch dﬂ Change RequestID I

Figure 37: Actions page

3. The following actions are available to be performed on a batch:

Approve (RDT)

Approve non-RDT Batch
Cancel Batch

Compare Report
Compare Report ULP
Get RDT File

Validation Report

The “Approve (RDT)” option mandates a Change Request Id to be put in the system for tracking
purposes.

4. Errors related to the action will be displayed on the upper left hand side of the screen.
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10. Rates

10.1 Updating the Rates

Purpose: The purpose of this tab is to let internal admins establish the rate that should be used for a
specific rate type and the effective date range.

1. Click on the “Rates” tab on the header block.

2. The system responds by showing the “Rates” screen.

% California ISO s> weicome: [

Shaping o Renewed Future M a ste r F l le

Upload Reports Status Actions Data Load Rates Notifications

Rates
Fiter-Rate  gogGuNT +
Rate Type Start Date End Date Rate change Reduest|  pdatedBy | LastUpdated | Comment
BIDSGMNT  |Oct 16,2013  [Oct 31,2013 [0 o | Oct 29,2013 |Pre-Activation ...
BIDSGMNT  [Nov01,2013  [Dec 31,2013 |0 ) Dec 26,2013 (oS rates Tor
BIDSGMNT  |[Jan 01,2014  [Dec 31,2014 [0 |l Dec 26,2013 |oMC rates for

2014

Rate Type Effective Start Date Effective End Date  Rate Change Request Id
v 01/23/2015 ﬁ 01/23/2015 @

Comment

255 characters remaining.

Figure 38: Rates page

3.  The internal admin user will select the appropriate rate type and the effective dates between which the
rate shall be valid along with a comment. The change request id is a mandatory field and must be
provided to update the rate.
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11. Notifications

11.1 Show notifications

Purpose: The purpose of this tab is to let internal admins enter a notification or message that will be
displayed on the bottom of the screen for all users. This feature can be used to keep the users
informed of any upcoming activities specific to the application such as planned maintenance.

1. Click on the “Notifications” tab on the header block.

2. The system responds by showing the “Notifications screen.

- California ISO | S—
Shaping a Renewed Fulure M a Ste r F ”e

Upload Reports Status Actions Data Load Rates Notifications

Notifications
Messages For Participants
Start Date End Date Updated By | Last Updated Message
MF freeze planned for FNM DB73 deployment: Dec.31-Jan.13, UI/API
Dec 24, 2014 |Dec 30, 2014 | Dec 24, 2014 |submission black-out period; Jan.8-15, effective date black-out period

(registered cost updates can be made effective Jan 9, 12 or 13).

MF freeze in progress for FNM DB73 deployment:Dec.31-Jan.13, UI/API
Dec 31, 2014 |Jan 13, 2015 | Dec 24, 2014 |submission black-out period; Jan.8-15, effective date black-out period
(registered cost updates can be made effective Jan 9,12 or 13

Effective Start Date Effective End Date
{ & &
Message

200 characters remaining.

Figure 39: Notifications page

3.  The internal admin user can upload the message not more than 200 characters and the effective dates
between which the notification will be shown
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12. Help

12.1 Help on the Master File User Interface

The help page is pointed to the Master File Homepage that includes key information about Master File as well
as this User Manual. A sample picture of the site is shown below. Here is the link to the Master File
Homepage: http://www.caiso.com/market/Pages/NetworkandResourceModeling/Default.aspx

Calendar Today's Outlook  Recent Documents News Careers Contact Us

&> California ISO »

ABOUT US PARTICIPATE STAY INFORMED PLANNING MARKET & OPERATIONS RULES
Home = Market Operations = Network and Resource Modeling

RS Accurate network modeling supports efficient market

Participate .
operations

Stay Informed

Planning Modeling is based on detailed information for transmission network elements, resources and

Market & Operations entities participating in the wholesale market.

Market Processes Requirements
C i iaht 1SO Tariff
LGl Bl LD Business Practice Manual for Managing the Full Netweork Model
o Business Practice Manual for Market Instruments

Network modeling

Outage Management The network model defines system parameters, price node and market scheduling limit mappings and planned network model
5 updates.

MEEETE SEEICTL (2 Full network model schedule

Metering and Telemetry @ Full Network Model Schedule - 2015 713172015 11:10

ﬁ Full Network Model Schedule -2016 73122015 11:10

Setilements

Transmission Operations @ Network model changes and pricing node mapping [

Full Network Model Pricing Nede Mapping (based on DB2016Q1 with EIM) 2/05/2016 11:53

%] Full Network Model Pricing Node Mapping (based on Full Network Model Release DB2016Q1) 200512016
11:53

Power Contracts Bulletin Board
Reports and Bulletins

Market Monitoring Change From Full Network Model DBE2015Q4 to Full Network Model DB2016Q1 20052016 11:53
@ Full Network Model DB2016Q1 Work Scope 1/26/2016 10:28
Full Network Medel Pricing Node Mapping (based on DB2015Q4 with EIM) 10/16/2015 09:36

&4 Full Network Model Pricing Node Mapping (based on Full Network Model Release DB2015Q4)
121612015 13:59

Change From Full Netwerk Model DBE2015Q3 to Full Network Meodel DB2015Q4 10162015 09:36
ﬁ Full Network Model DB2015Q4 Work Scope 101612015 08:36

Rules

Figure 40: Help Web Page
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13. Troubleshooting/FAQ

13.1 In the RDT Upload function what is an acceptable file name for the upload?

Any standard Windows file names are acceptable. While spaces are allowed in the file name, the
following characters should be avoided: &, @, and ;

13.2 How do | see the report parameters once the report has been saved?
The report parameters are displayed on the Instruction sheet of the report.

The instruction sheet also displays the Report Generation Timestamp which shows the time at which the
data was queried.

13.3 Do the reports display pending data?

No, the reports display only ‘Approved’ data.

13.4 Do the reports display resources that do not have an association with an SCID?

No, the reports display only those resources that have an active association with the selected SCID for a
selected trade date.

13.5 Why can’t | see all the resources in the RESOURCE_ID drop down list?

The report screen’s drop-down-list of Resource IDs displays only those resources that have an active
association with the selected SC ID for the specified resource type and trade date.

13.6 Can the report be generated for multiple SC IDs into a single output?

No, the reports can be generated for only one SCID at a time.

13.7 In what order is the data sorted in the reports?
The reports display the data based on the following sort order:

For the Intertie RDT Report, the resource records shall be sorted on the following fields in an ascending
order

RES_TYPE

RES_ID
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For the Generator RDT Report, the resource records shall be sorted on the following fields in an

ascending order:
« RES_TYPE
- RES_ID

For segments data on the Generator RDTSs, the records shall be sorted on the following fields in an
ascending order:

- RES.ID
. SEG_TYPE worksheets to appear in this order (RAMP, HEAT, STRT, FRBD, REG, RREG,
ROPR)
- SEG_NUM
13.8 Which application sources the RA / MOO values? Is it Master File?

1. The GRDT no longer displays RA data. RA data is available via CIRA
2. The MOO Qualified flag is sourced from Master File.
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14. Contact Information

o During Testing please follow the Issue Reporting Information instructions in the Master File
Data Exchange External Testing instructions
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Appendix A — External User Access

A.1 Digital Certificate

A Digital Certificate must be obtained and installed before you can access the Master File User Interface for
the first time.

Please submit your request utilizing the current User Application Access Request Form. The User Application
Access Request Form can be found at the following link:

http://www.caiso.com/pubinfo/info-security/certs/index.html

When requesting application access, please download the latest form from the website every time. The User
Application Access Request Form continues to be very dynamic as new applications and environments are
rolled out. By accessing the current form every time, you will be able to select from all the available
applications and environments, and all the necessary information will be collected.

= Fill out the form following the instructions, as shown below.
* Save as an Excel file to your drive.
« Email the completed form to CertRequest@caiso.com

A.2 Certificate Installation

Once approved, Certificate Request replies via e-mail with the Digital Certificate and password. A password
is required for the initial login only. All ensuing accesses automatically connect you.

» Save the certificate file and installation PIN in a secure location for possible future use and follow the
installation instructions provided.

A.3 Accessing the Master File User Interface

+ Type the appropriate URL address into your browser address bar.

Master File Production Environment

https://portal.caiso.com

Select Master File
ra) Master File
or

https://portal.caiso.com/mf
Port number is 443
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Appendix B — User Messages

User Messages

Message Name

Message Text

When Message will be
shown

RDT Upload

rdtUpload_fileName_required_
msg

RDT input file is required

No input file has been provided

rdtUpload_fileName_validation
msg

RDT input file name must be < 100
characters

File name entered is > 100 chars

r_dtUpload_scid_required_msg

SC Id required

SC Id not entered

rdtUpload_rdtType_required_
msg

RDT type is required

RDT Type is not selected (Gen or
Intertie)

rdtUpload_effectiveDate_requir
ed_msg

Effective date is required

Effective date is not entered or
selected

rdtUpload_effectiveDate_msg

Effective date must be setto a
minimum of today + 5 business

Effective date rule has been
broken

days
rdtUpload_comments_validatio Comments must be < 255 More than 255 bytes has been
n_msg characters entered
rdtUpload_success_msg RDT file was successfully All'is good

uploaded

rdtUpload_processing_error_m
Sg

Errors encountered trying to
process RDT; see errors below

Errors in the RDT data

rdtUpload_archiving_error_ms
g

Error archiving RDT

Internal Error

rdtUpload_transformation_erro
r_msg

Error transforming RDT

Internal Error

rdtUpload_calendar_error_ms
g

Error calling calendar service

Internal Error

rdtUpload_error_msg

Errors processing request; see log
files for details

Bad system error, contact ISO
Support with time error occurred
and by who

submitRdtDescription

{0} updates were successfully
received.

API —When submission is
successful. The parameter is the
number of updates submitted.

submitRdtResult

Records received={0}",
batchld={1}'

APl — W hen submission is
successful, the API returns this as
a message. The first parameter is
the number of records, second is
the batch id.

submitRdtResultError

Errors encountered

API —when any errors are
detected, this will be the message
that the API will show.

rdtProcessorUserComment

Updated via the {0}"

This is the default User Comment
that will be applied to all resources
in the batch. The parameter will
have ‘Ul' or ‘API’ as its possible
values.

! The curly braces mean that a value will be substituted, multiple substitutions per message are possible
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Internal message

Invalid Spreadsheet

This error would be displayed if
you passed it a file that is not a
XLS file or the XLS file is corrupted
/ can not be read

Internal message

{sheetMapping.sheetName} sheet
not found in xIs.

The required sheets are defined in
the XML config file and if one sheet
is not found in the XLS you will
receive this message

Internal message

Missing sheet {sheetName}

This error is redundant and will not
occur. It will be caught by the
check in previous line’s validation .

Internal message

{segment},
{resld}{sheetMapping.resldCol}{ro
w}, Parent resource not found

This error will be displayed if
segment data for a Resource Id is
being updated but there is no
record of the Resource Id on the
Resource sheet

Internal message

Missing segment sheet {segment}

This error is redundant and will not
occur. The existence of
worksheets has already been
validated.

Internal message

Value required for
{mappingEntry.description}

This error would occur if the XML
config file has a field set to
required = true. Currently the
Resource Id field is the only field
that is required on
Intertie/Generator submissions

Internal message

{Resource ID}: RDT resource does
not exists in approved status for a
given start date

This error would occur if a
submitted resource does not have
an Approved version that matches
the given start date.

Internal message

{Resource ID}: RDT resource does
not belong to selected SC for a
given start date

This error would occur if a
submitted resource doesn’t have
an Association to the Market
Participant that the submitter is
authorized to submit for on the
given start date.

RDT Status

rdtStatus_no_records_found_
msg

No status records found for scid

{o}*

Status query can’t find any
submissions, the parameter is the
SC_ID that was searched for

rdtStatus_error_msg

Errors processing request; see log
files for details

System Error, contact ISO support

rdtStatus_scid_required_msg

SC Id required

You must enter an SC ID

Common Messages

missingUserld

You are not authorized for this
request

You shouldn’t see this message
since you shouldn’t be able to
choose any option that is not valid
for your use.

missingScld A valid Scheduling Coordinator is When a SC_ID is presented that
required doesn’t match the security
certificate of the User.
serviceError Error accessing service: {0} API| —trying to access one of the
API Services that doesn’t exist or
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you provided inappropriate input to.
The parameter is the name of the
service that you are trying to use.
noResultsFound No results were found API —When no records match the

record you are searching for.

! The curly braces mean that a value will be substituted; multiple substitutions per message are possible
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Generator RDT Field Error Messages

Field Name Message Text When Message will be shown
Resource

PGA Name PGA Name > 80 characters More than 80 chars are present
Resource ID Resource ID > 32 characters More than 32 chars are present
Resource Name Resource Name > 40 characters More than 40 chars are present
Resource Type Resource Type needs to be ‘GEN’, | Invalid Res Type presented

‘TG’, or LOAD’

Aggregate Resource

Aggregate? Needs to be Y’ or ‘N’

Invalid value presented

Energy Type Energy Type needs to be ‘DYN’, | Invalid value presented
‘FIRM’, or null

Gen Tech Type Prime Mover Technology needs to | Invalid value presented
be 'CCYC', 'GTUR', '"HYDR', 'OTHR,
'PHOT', 'PTUR', ‘PUMP’, 'RECP',
'STUR', 'SYNC', or 'WIND'

Gen Type Generator Type must be must be 'H' | Invalid value presented
or'T

Fuel Region Fuel Region needs to be 'CISO', | Invalid value presented

'PGE2', ‘SCE?’, 'SCE2', 'SDGL1', or
'SDG2'

Air  Quality Management
District

Air Quality Management District > 4
characters

More than 4 chars are present

Max Gen Maximum  Generation  Capacity | Not a proper number
needs to be a valid number
Min Gen Minimum Generation Capacity needs | Not a proper number

to be a valid number

Min Dispatchable Level

Minimum Dispatchable Level needs
to be a valid number

Not a proper number

Min On Time

Minimum On Time needs to be a
valid number

Not a proper number

Max On Time

Maximum On Time needs to be a
valid number

Not a proper number

Max Off Time

Maximum Off Time needs to be a
valid number

Not a proper number

Max Startups Per Day

Maximum Startups Per Day needs to
be a valid number

Not a proper number

Min Load Cost

Minimum Load Cost needs to be a
valid number

Not a proper number

Cost Basis

Cost Basis values are ‘PRXC’ or
‘REGC’

Invalid value presented

Max Pump Capacity

Maximum Pump Capacity needs to
be a valid number

Not a proper number

Pump Min Cost

Pump Minimum Cost needs to be a
valid number

Not a proper number

Pumping Factor

Pumping Factor needs to be a valid
number

Not a proper number

Pump Max Daily Startups

Maximum Pump Capacity needs to

Not a proper number
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be a valid number

Pump Min Up Time

Pump Minimum Up Time needs to
be a valid number

Not a proper number

Pump Min Down Time

Pump Minimum Down Time needs to
be a valid number

Not a proper number

Pump Max Shutdown Cost

Pump Maximum Shutdown Cost
needs to be a valid number

Not a proper number

Pump Shutdown Time

Pump Shutdown Time needs to be a
valid number

Not a proper number

Variable Cost Option

Variable Cost Option needs to be '1',
'2'or '3

Invalid value presented

Negotiated Rate Option

Negotiated Rate Option needs to be
'1','2'or '3

Invalid value presented

LMP Option

LMP Option needs to be '1', '2' or '3’

Invalid value presented

Reserve Capacity: Spin

Reserve Capacity: Spin needs to be
a valid number

Not a proper number

Reserve Capacity: NSpin

Reserve Capacity: Non-Spin needs
to be a valid number

Not a proper number

Certified PIRP

Certified PIRP needs to be 'Y' or 'N'

Invalid value presented

RA Flag Resource Adequacy Flag needs to | Invalid value presented
be 'Y' or 'N'

MOO Flag Must Offer Obligation Flag needs to | Invalid value presented
be 'Y' or 'N'

RA Capacity Resource Adequacy Capacity needs | Not a proper number
to be a valid number

MOO Quialified Must Offer Obligation Qualified Flag | Invalid value presented
needs to be 'Y’, 'N' or 'R’

Startup Code Type Startup Code Type > 4 characters More than 4 chars are present

PGA Flag Participating Generator Agreement | Invalid value presented
Flag needs to be "Y' or 'N'

COG Constrained Output Generator Flag | Invalid value presented

needs to be "Y' or 'N'

Certified RUC

Certified for RUC? needs to be 'Y' or
N

Invalid value presented

LMPM Flag

Market Power Mitigation Participation
Flag needs to be 'Y' or 'N'

Invalid value presented

Certified for AS: Regulation

Certified for AS: Regulation needs to
be "Y' or 'N'

Invalid value presented

Certified for AS: Spin

Certified for AS: Spin needs to be 'Y
or'N'

Invalid value presented

Certified for AS DAM:NSpin

Certified for AS DAM: Non-Spin
needs to be 'Y' or 'N'

Invalid value presented

Certified for AS RTM:NSpin

Certified for AS RTM: Non-Spin
needs to be 'Y' or 'N'

Invalid value presented

MSS Load Following Down

MSS Load Following Down needs to
be 'Y' or 'N'

Invalid value presented

MSS Load Following Up

MSS Load Following Up needs to be
"Y' or 'N'

Invalid value presented

QF Flag FERC Qualifying Facility Flag needs | Invalid value presented
to be 'Y' or 'N'
Use Limit Flag Use Limit needs to be 'Y' or 'N' Invalid value presented

Operating Maintenance Cost

Operating Maintenance Cost needs
to be a valid number

Not a proper number
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Priority Type Priority Type > 4 characters More than 4 chars are present
Dispatchable Flag Dispatchable needs to be "Y' or 'N' Invalid value presented
RMR Flag RMR needs to be 'Y' or 'N' Invalid value presented

Max Ramp Rate

Maximum Ramp Rate needs to be a
valid number

Not a proper number

Price Setter —- DAM

Price Setter - DAM needs to be 'Y' or
N

Invalid value presented

Price Setter - RTM

Price Setter - RTM needs to be 'Y' or
N

Invalid value presented

RAMP RATE Segments

Resource Id

Resource ID > 32 characters

More than 32 chars are present

Segment Number

Segment Number needs to be a valid
number

Not a proper number

Operating Level

Operating Level needs to be a valid
number

Not a proper number

Worst
Rate

Operational Ramp

W orst Operational Ramp Rate needs
to be a valid number

Not a proper number

Best Operational Ramp Rate

Best Operational Ramp Rate needs
to be a valid number

Not a proper number

HEAT RATE Segments

Resource Id

Resource ID > 32 characters

More than 32 chars are present

Segment Number

Segment Number needs to be a valid
number

Not a proper number

Heat Rate Operating Level

Heat Rate Operating Level needs to
be a valid number

Not a proper number

Heat Rate

Heat Rate needs to be a valid
number

Not a proper number

Heat Emission Rate

Heat Emission Rate needs to be a
valid number

Not a proper number

Average Cost

Average Cost needs to be a valid
number

Not a proper number

STARTUP Segments

Resource Id

Resource ID > 32 characters

More than 32 chars are present

Segment Number

Segment Number needs to be a valid
number

Not a proper number

Registered Cooling Time

Registered Cooling Time needs to be
a valid number

Not a proper number

Start-Up Time

Start-Up Time needs to be a valid
number

Not a proper number

Start-Up Cost

Start-Up Cost needs to be a valid
number

Not a proper number

Start-Up Aux

Start-Up Aux needs to be a valid
number

Not a proper number

Start-Up Fuel

Start-Up Fuel needs to be a valid
number

Not a proper number

FORBIDDEN Segments

Resource Id

Resource ID > 32 characters

More than 32 chars are present

Segment Number

Segment Number needs to be a valid
number

Not a proper number

Lower MW of Forbidden | Lower MW of Forbidden Region | Nota proper number
Region needs to be a valid number
Upper MW of Forbidden | Upper MW of Forbidden Region | Nota proper number
Region needs to be a valid number
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Crossing Time

Crossing Time of Forbidden Region
needs to be a valid number

Not a proper number

REGULATION Segments

Resource Id

Resource ID > 32 characters

More than 32 chars are present

Segment Number

Segment Number needs to be a valid
number

Not a proper number

Lower MW of Regulation

Lower MW for Regulation needs to
be a valid number

Not a proper number

Upper MW of Regulation

Upper MW for Regulation needs to
be a valid number

Not a proper number

REG RAMP RATE
Segments
Resource Id Resource ID > 32 characters More than 32 chars are present
Segment Number Segment Number needs to be a valid | Not a proper number
number
Worst Regulation Ramp | Worst Regulation Ramp Rate needs | Not a proper number
Rate to be a valid number

Best Regulation Ramp Rate

Best Regulation Ramp Rate needs to
be a valid number

Not a proper number

OPER RES RAMP RATE
Segments

Resource Id

Resource ID > 32 characters

More than 32 chars are present

Segment Number

Segment Number needs to be a valid
number

Not a proper number

W orst Operating Res Ramp
Rate

Worst Operating Res Ramp Rate
needs to be a valid number

Not a proper number

Best Operating Res Ramp
Rate

Best Operating Res Ramp Rate
needs to be a valid number

Not a proper number

Intertie RDT Field Error Messages

Field Name Message Text When Message will be shown
Resource

Res ID Resource ID > 32 characters More than 32 chars are present
Energy Type Energy Type needs to be 'FIRM', | Invalid value presented

'NFRM', 'WHL', or 'UCTG'

Min Hourly Block Limit

Minimum Hourly Block Limit needs to
be a valid number

Not a proper number

Certified for AS: Spin

Certified for A/S: Spin needs to be 'Y’
or'N'

Invalid value presented

Certified for AS DAM: Non-

Certified For A/S Non Spin DAM

Invalid value presented

Spin needs to be 'Y' or 'N'
Certified for AS RTM: Non- Certified for A/S Non Spin RTM | Invalid value presented
Spin needs to be "Y' or 'N'

Spinning Reserve Capacity

Spinning Reserve Cap needs to be a
valid number

Not a proper number

Non-Spinning Reserve
Capacity

Non-Spinning Reserve Cap needs to
be a valid number

Not a proper number

Certified for RUC

Certified for RUC needs to be 'Y' or
N

Invalid value presented

RA Resource

RA Resource needs to be 'Y' or 'N'

Invalid value presented

MOO Flag MOO Resource needs to be 'Y' or 'N' | Invalid value presented
RA Capacity Resource Adequacy Capacity needs | Not a proper number
to be a valid number
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MOO Quialified Must Offer Obligation Invalid value presented
Qualified needs to be 'Y, 'N',
Wheeling Ref Number Wheeling Reference Number > 32 | More than 32 chars are present
characters

Use Limit Plan (ULPDT) Field Error Messages

Field Name Message Text When Message will be shown
Resource
Scheduling Coordinator SC '[value provided in the template]' is | SC ID not valid for authenticated
not available to current user. user.
Value required. Value not provided
For use limit plan data, the submitting [ULPDT SC not associated to the
SC must own the resource on the Resource on the Plan Start Date

start date of the plan.

Resource ID Resource '[value provided in the Resource doesn't exist with status of|
template]' does not exist or is not ‘A
active.
Value required. Value not provided
Use Limit Type The provided use limit type '[value Invalid Use Limit Type is entered.

provided in the template]' is not
valid. Valid values [list of available

values]
Resource '[value provided in the Resource is not provisioned to SC
template] does not belong to SC represented by authenticated user.

'[value provided in the template]'.

Value required. Value not provided

Granularity The provided granularity '[value Invalid Granularity is entered.
provided in the template]' is not
\valid. Valid values [ANNUALLY,
DAILY, MONTHLY, OTHER,

ROLL_12]
Value required. Value not provided
ULPs with granularity of ANNUALLY | Annual Plan does not span a full
must span a multiple of 12 months year (or several full years)

ULPs with granularity of ROLL_12 Rolling 12 Plan does not span 12 or
must cover twelve or more whole more full months
calendar months

Effective Start Date Value required. Value not provided
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Similar ULP with overlapping dates
exists with a use limit plan status of
Incomplete (1) or Completed (C).

Submitted Plan overlaps a similar
Plan (same Resource ID, Limit
Type, Granularity, and
Configuration, if applicable) that is in
‘I (Incomplete) or ‘C’ (Complete)
status.

ULPs start date overlaps similar
approved ULP

Submitted Plan start date overlaps a
similar approved Plan (same
Resource ID, Limit Type,
Granularity, and Configuration, if
applicable)

The plan start date for '[value
provided in the template]' must fall
between start and end date of an
approved configuration

A Plan with a Configuration has a
start date that does not fall within the
effective dates of an approved
Confiauration

The effective start date for the same
Resource ID, Use Limit Type and
Granularity is within the effective start
date and effective end date in row
‘[value provided in the template]'

Two or more submitted ULPs have
overlapping dates

Effective start date must align with the
first day of the month unless
granularity is '‘DAILY"

A non-DAILY ULP has a start date
other than the first of the month.

ULPs must have a start and end
effective dates

A Plan was submitted with a null start
date and/or a null end date

Effective End Date

Effective end date must be after
effective start date

Invalid date presented

Value required.

Value not provided

Effective end date must align with the
last day of the month unless
granularity is 'DAILY"

A non-DAILY ULP has an end date
other than the last day of the month.

The end date of the submitted use
limit plan must be greater than or
equal to the submission date

A Plan was submitted for a date
range in the past.

ULPs end date overlaps similar
approved ULP

Submitted Plan end date overlaps a
similar approved Plan (same
Resource ID, Limit Type,
Granularity, and Configuration, if
applicable)

Limitation Number

Limitation number must be a valid non-
negative number

Invalid value presented

Value required.

Value not provided
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Limitation number must be a valid A negative Limitation was submitted
non-negative number
Limitation number is 0; ULP will be A Limitation of 0 was submitted
deleted
Limitation number for START type A fraction was entered for the
must be a whole number Limitation on a Plan with Limitation
Type of START
Minimum Capacity Level Minimum Capacity Level must be a Invalid value presented

valid non-negative number

Maximum Capacity Level Maximum Capacity Level must be a Invalid value presented
valid non-negative number.

Maximum capacity level has to be Invalid value presented
greater than minimum capacity.

Documentation Name Documentation Name is required and | Value is missing or too large
cannot be greater than 255 characters

Configuration ID Configuration '[value provided in the Resource does not have an
template]' does not exist or is not approved Configuration at the time
effective on plan start date of the Plan start date
Resource '[value provided in the Resource does not have an
template]' does not have an approved | approved Configuration at the time
configuration of the Plan start date

Use Limit Plan (ULPDT) File Error Messages

Message Text When Message will be shown
ULPDT file is required. File Name not provided

Instruction worksheet not included in ULPDT

'Instruction' sheet not found in xIs. Could not determine .
submitted.

ULPDT version.

Invalid version number specified in
ULPDT version [uploaded version number] is not Instruction worksheet of ULPDT.
supported. Support version(s) [supported version number(s)]

Version number provided in Instruction

Could not determine ULPDT version on A2 in the 'Instruction’ .
worksheet is not of the correct format.

sheet. The version for ULPDT data should be in the format
\VERSION ULPDT.X.X

The resource use limit flag is not set to 'Y". Resource Use Limit Flag must be ‘Y’ prior to
Use Limit Plan submittal for a Resource.
(Use Limit Flag can be updated in GRDT.)

ULPDT contains deletion. A ULP was submitted with a Limitation
Limitation number is 0; ULP will be deleted. Number of 0.
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